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The Essential Microsoft Excel 

Formulas Cheat Sheet 
Date and Time

=NOW Show the date and time 
=TODAY() Show the current date without 

the time 
=DAY(TODAY()) Show today's date in a cell 
=MONTH(TODAY()) Show current month in a cell 
=TODAY()+10 Add 10 days to current date 

Counting and Rounding 
=SUM Calculates the sum of a group 

of values 
=AVERAGE Calculates the mean of a 

group of values 
=COUNT Counts the number of cells in 

a range that contains 
numbers 

=INT Removes the decimal portion 
of a number 

=ROUND Rounds a number to a 
specified number of decimal 
places 

=IF Tests for a true or false 
condition 

=NOW Returns the date and time 
=TODAY Returns the date, without the 

time 
=SUMIF Calculates a sum from a group 

of values in which a condition 
has been met 

=COUNTIF Counts the number of cells in 
a range that match a criteria 

=COUNTA(A1:A5) Count the number of non-
blank cells in a range 

=ROUND(1.45, 1) Rounds 1.45 to one decimal 
place 

=ROUND(-1.457, 2) Rounds -1.457 to two decimal 
places 

=TRUE Returns the logical value 
TRUE 

=FALSE Returns the logical value 
FALSE 

=AND Returns TRUE if all of its 
arguments are TRUE 

=OR Returns TRUE if any 
argument is TRUE 

Unit Conversion 
=CONVERT(A1,"day","hr") Converts value of A1 

from days to hours 
=CONVERT(A1,"hr","mn") Converts value of A1 

from hours to minutes 
=CONVERT(A1,"yr", "day") Converts value of A1 

from years to days 
=CONVERT(A1,"C","F") Converts value of A1 

from Celsius to 
Fahrenheit 

=CONVERT(A1,"tsp","tbs") Converts value of A1 
from teaspoons to 
tablespoons 

=CONVERT(A1,"gal","l") Converts value of A1 
from gallons to liters 

=CONVERT(A1,"mi","km") Converts value of A1 
from miles to kilometers 

=CONVERT(A1,"km","mi") Converts value of A1 
from kilometers to miles 

=CONVERT(A1,"in","ft") Converts value of A1 
from inches to feet 

=CONVERT(A1,"cm","in") Converts value of A1 
from centimeters to 
inches 

=BIN2DEC(1100100) Converts binary 1100100 
to decimal (100) 

=ROMAN Converts a number into a 
Roman numeral 

Mathematics 
=B2-C9 Subtracts values in the two 

cells 
=D8*A3 Multiplies the numbers in the 

two cells 
=PRODUCT(A1:A20) Multiplies the cells in the range 
=PRODUCT(F6:A1,2) Multiplies the cells in the 

range, and mulitplies the result 
by 2 

=A1/A3 Divides value in A1 by the value 
in A3 

=MOD Returns the remainder from 
division 

=MIN(A1:A9) Calculates the smallest 
number in a range 

=MAX(C27:C34) Calculates the largest number 
in a range 
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=SMALL(B1:B7, 2) Calculates the second smallest 
number in a range 

=LARGE(G13:D7,3) Calculates the third largest 
number in a range 

=POWER(9,2) Calculates nine squared 
=9^3 Calculates nine cubed 
=FACT(A1) Factorial of value in A1 
=EVEN Rounds a number up to the 

nearest even integer 
=ODD Rounds a number up to the 

nearest odd integer 
=AVERAGE Calculates the average 
=MEDIAN Calculates the median 
=SQRT Calculates the square root of a 

number 
=PI Shows the value of pi 
=POWER Calculates the result of a 

number raised to a power 
=RAND Returns a random number 

between 0 and 1 
=RANDBETWEEN Returns a random number 

between the numbers you 
specify 

=COS Calculates the cosine of a 
number 

=SIN Returns the 
sine of the given 
angle 

Calculates the sine of the given 
angle 

=TAN Calculates the tangent of a 
number 

=CORREL Calculates the correlation 
coefficient between two data 
sets 

=STDEVA Estimates standard deviation 
based on a sample 

=PROB Returns the probability that 
values in a range are between 
two limits 

Text 
=LEFT Extracts one or more 

characters from the left side of 
a text string 

=RIGHT Extracts one or more 
characters from the right side 
of a text string 

=MID Extracts characters from the 
middle of a text string 

=CONCATENATE Merges two or more text 
strings 

=REPLACE Replaces part of a text string 
=LOWER Converts a text string to all 

lowercase 

=UPPER Converts a text string to all 
uppercase 

=PROPER Converts a text string to 
proper case 

=LEN Returns a text string’s length in 
characters 

=REPT Repeats text a given number 
of times 

=TEXT Formats a number and 
converts it to text 

=VALUE Converts a text cell to a 
number 

=EXACT Checks to see if two text 
values are identical 

=DOLLAR Converts a number to text, 
using the USD currency format 

=CLEAN Removes all non-printable 
characters from text 

Finance 
=INTRATE Calculates the interest rate for 

a fully invested security 
=EFFECT Calculates the effective annual 

interest rate 
=FV Calculates the future value of 

an investment 
=FVSCHEDULE Calculates the future value of 

an initial principal after 
applying a series of compound 
interest rates 

=PMT Calculates the total payment 
(debt and interest) on a debt 
security 

=IPMT Calculates the interest 
payment for an investment for 
a given period 

=ACCRINT Calculates the accrued interest 
for a security that pays 
periodic interest 

=ACCRINTM Calculates the accrued interest 
for a security that pays interest 
at maturity 

=AMORLINC Calculates the depreciation for 
each accounting period 

=NPV Calculates the net present 
value of cash flows based on a 
discount rate 

=YIELD Calculates the yield of a 
security based on maturity, 
face value, and interest rate 

=PRICE Calculates the price per $100 
face value of a periodic coupon 
bond 
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Microsoft Office for Mac 
Keyboard Shortcut Cheat Sheet

Basic Shortcuts Across Applications 
Cmd + P or Ctrl + P Print 

Cmd + F Find 

Cmd + X or Ctrl + X Cut 

Cmd + C or Ctrl + C Copy 

Cmd + V or Ctrl + V Paste 

Cmd + S or Ctrl + S Save 

Cmd + Z or Ctrl + Z Undo 
Cmd + Y or Ctrl + Y or Cmd 
+ Shift + Z Redo 

Cmd + Ctrl + R
Minimize or maximize 
the ribbon 

Microsoft OneNote 

Option + Tab 
Switch between 
notebook sections 

Cmd + Shift + Up Arrow 
Move selected 
paragraphs up 

Cmd + Shift + Down Arrow Move selected 
paragraphs down 

Cmd + Shift + Left Arrow Move selected 
paragraphs left 

Ctrl + Tab [ + Use arrow 
keys to move up or down] Switch between pages 

Shift + Return Insert a line break 

Cmd + D Insert the current date 

Cmd + Shift + Down Arrow 
Insert the current date 
and time 

Cmd + K Insert a link 

Option + Delete 
Delete the word to the 
left 

Fn + Option + Delete 
Delete the word to the 
right 

Ctrl + G 
View a list of open 
notebooks 

Cmd + Option + F Search all notebooks 

Cmd + N 
Create a notebook 
page 

Cmd + Shift + M Move a page 

Cmd + Shift + C Copy a page 

Microsoft Outlook 
Email 
Cmd + N Create a message 

Cmd + S Save the open message to Drafts 
Cmd + Return Send the open message 

Cmd + E 
Add an attachment to the open 
message 

Cmd + K Send and receive all messages 

Cmd + R Reply to the message 

Shift + Cmd + R Reply to all 

Cmd + J Forward the message 

Microsoft Outlook 
Calendar, Notes, Tasks, and Contacts 

Cmd + N Create an event, note, task, or
contact 

Cmd + O (letter 
O) 

Open the selected event, note, 
task, or contact 

Delete 
Delete the selected event, note, 
task, or contact 

Shift + Ctrl + [ Navigate to the previous pane 

Shift + Ctrl + ] Navigate to the next pane 

Cmd + T 
Switch the calendar view to include 
today 

Cmd + J Send the note as an email 

Microsoft Outlook 

Flagging Messages, Tasks, and Contacts 

Ctrl + 1 Today 

Ctrl + 2 Tomorrow 

Ctrl + 3 This week 

Ctrl + 4 Next week 

Ctrl + 5 No due date 

Ctrl + 6 Custom due date 

Ctrl + = Add a reminder 

0 (zero) Mark complete 
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Microsoft Word 
Cmd + E Center a paragraph 

Cmd + J Justify a paragraph 

Cmd + L Left align a paragraph 

Cmd + R Right align a paragraph 

Cmd + Shift + > Increase font size 

Cmd + Shift + < Decrease font size 

Cmd + Shift + A Apply all capital letters 

Cmd + B Apply bold 

Cmd + I (letter I) Apply italics 

Cmd + U Apply underline 

Cmd + Shift + D Apply double underline 

Cmd + 1 Single-spacing 

Cmd + 2 Double-spacing 

Cmd + 5 1.5 line-spacing 

Shift + Return Insert a line break 

Shift + Enter Insert a page break 

Cmd + Shift + Enter Insert a column break 

Option + G 
Insert a copyright 
symbol 

Option + 2 Insert a trademark 
symbol 

Option + R Insert a registered 
trademark symbol 

Option + ; (semicolon) Insert an ellipsis 

Cmd + Shift + N Apply style - Normal 

Cmd + Shift + L Apply style - List 

Cmd + Option + 1 Apply style -  Heading 1 

Cmd + Option + 2 Apply style -  Heading 2 

Cmd + Option + 3 Apply style -  Heading 3 

Microsoft PowerPoint 
Cmd + N Create a presentation 

Cmd + O (letter O) Open a presentation 

Cmd + W Close a presentation 

Cmd + P Print a presentation 

Cmd + S Save a presentation 
Cmd + Shift + N or Ctrl + 
N Insert a slide 

Cmd + Shift + Return Play from the first slide 

Cmd + Return 
Play from the current 
slide 

Microsoft PowerPoint continued… 
Esc or Cmd + . (period) or 
- (hyphen)

End the slide show 

Ctrl + H Hide the pointer 

Cmd + 1 Normal view 

Cmd + 2 Slider sorter view 

Cmd + 3 Notes page view 

Cmd + 4 Outline view 

Cmd + Ctrl + F Full screen view 

Option + Return Presenter view 

B 
Turn the screen black 
while in presentation 
mode 

W 
Turn the screen white 
while in presentation 
mode 

Microsoft Excel 
Ctrl + Shift + = Insert cells 

Cmd + - or Ctrl + - Delete cells 

Cmd + Shift + K Group selected cells 

Cmd + Shift + J Ungroup selected cells 

Cmd + K or Ctrl + K Insert a hyperlink 

Cmd + D or Ctrl + D Fill down 

Cmd + R or Ctrl + R Fill right 

Ctrl + ; (semicolon) Enter the date 

Cmd + ; (semicolon) Enter the time 

Cmd + Shift + * (asterisk) Select only visible cells 

Shift + Delete 
Select only the active 
cell when multiple cells 
are selected 

Shift + Spacebar Select the row 

Ctrl + 9 Hide rows 

Ctrl + Shift + ( Unhide rows 

Ctrl + Spacebar Select the column 

Ctrl + 0 (zero) Hide columns 

Ctrl + Shift + ) Unhide columns 

Shift + Return Complete an entry and 
move up 

Tab Complete an entry and 
move right 

Shift + Tab 
Complete an entry and 
move left 

Esc Cancel an entry 
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Microsoft Excel continued 

Shift + F2 Insert, open, or edit a 
comment 

Ctrl + Delete Scroll to the active cell 
in a worksheet 

Tab 
Move between 
unlocked cells on a 
protected worksheet 

Ctrl + Page Down or 
Option + Right Arrow 

Move to the next sheet 
in a workbook 

Ctrl + Page Up or Option 
+ Left Arrow

Move to the previous 
sheet in a workbook 

Home or Fn + Left Arrow Move to the beginning 
of the row 

Ctrl + Home or Ctrl + Fn + 
Left Arrow 

Move to the beginning 
of the sheet 

Ctrl + End or Ctrl + Fn + 
Right Arrow 

Move to the last cell in 
use on the sheet 

Page Up or Fn + Up 
Arrow Move up one screen 

Page Down or Fn + Down 
Arrow 

Move down one screen 

Option + Page Up or Fn + 
Option + Up Arrow 

Move left one screen 

Option + Page Down or 
Fn + Option + Down 
Arrow 

Move right one screen 
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CTRL + A Select all elements on screen

CTRL + B  Format text as bold

CTRL + I Italicizes text

CTRL + U Underline selected text

CTRL + P Launches the Print dialogue

CTRL + C Copy the selected text to the clipboard

CTRL + X Cut the selected text (remove and place it on the clipboard)

CTRL + V Paste clipboard content

CTRL + Z Undo the last action and can be used several times in a row

CTRL + Y Redo the last action

F4 Repeat the last action you took, whether that be formatting 
or deleting text

CTRL + F1 Hide/reveal the ribbon interface

SHIFT + F7 Reveal the thesaurus tab

 CTRL + K Add a hyperlink to some text to link to another file or a web 
address

CTRL + S Save the document

CTRL + F6 Switch between multiple files

CTRL + SHIFT + G Invoke the word counter

F7 Open Spelling and Grammar

SHIFT + F3 Toggle between lowercase, all caps, and title case

CTRL + = Subscript highlighted text

CTRL + SHIFT + = Superscript highlighted text

CTRL + SHIFT + F9 Remove any hyperlinks in text

CTRL + SPACE  Remove any font effects and reset it to the default 
size, font, and color

CTRL + ] Increase the font size

CTRL + [ Decrease the font size

 ALT > W > R  Toggle the ruler

CTRL + M Add a new slide in the editor

CTRL + Shift + D Duplicate the current slide

F5 Launch a slideshow from the beginning

CTRL + Shift + F5 Launch slideshow from the current slide

Press a number 
> Enter Jump to a certain slide while presenting

B Display a blank black slide. Press again to return to 
current slide

W Display a blank white slide. Press again to return to 
current slide

CTRL + P  Activate the pen tool

E Clear the annotation during presentation

CTRL + A Invokes the mouse cursor during presentation

CTRL + H Hide the mouse cursor during presentation

S Stop or restart the slideshow

ALT + P  Play/Pause embedded media in slide

ALT + Q Stop playback

ALT + ⬆/⬇ Adjust the volume of playback

CTRL + Page ⬆/Page ⬇ Scroll between multiple tabs

CTRL + Backspace Focus the screen on the active cell

ALT + ENTER Enter a new line in a cell

CTRL + ;  Quickly enter the current date

CTRL + Shift + : Quickly enter the current time

CTRL + 1  Invoke the Formatting dialogue box

 F2 Invoke the Formula box

CTRL + `  Toggle between cells to reveal content or 
formulas

CTRL + 0  Hide a column

CTRL + 9 Hide a row

CTRL + Shift + 0/9 Unhide anything hidden by CTRL + 0/9

ALT > H > O > U > L  Unhide anything hidden by CTRL + 0/9

ALT + =  Automatically apply SUM to any highlighted cells

CTRL + Arrow Keys Warp in the direction you choose, stopping at the 
first black/filled cell 

CTRL + Shift + *  Select the current row or column
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Essential Microsoft Office Keyboard 
Shortcuts for Word, Excel and PowerPoint 

All Programs PowerPoint

ExcelWord
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OneNote Keyboard Shortcuts 
Common Keyboard Shortcuts 

Ctrl + M Open a new OneNote Window 

Ctrl/Cmd + Z Undo the last action 

Ctrl/Cmd + Y Redo the last action 

Ctrl/Cmd + A  
Select all the items on a current page (to expand the selection, press the keys 
again) 

Ctrl/Cmd + X  Cut the selected text or item  

Ctrl/Cmd + C Copy the selected text or item to the clipboard 

Ctrl/Cmd + V Paste the contents of the clipboard 

Ctrl/Cmd + K  Insert a hyperlink 

Ctrl/Cmd + B Apply or remove bold formatting 

Ctrl/Cmd + I Apply or remove italics formatting 

Ctrl/Cmd + U  Apply or remove underline formatting 

Ctrl/Cmd + Alt/Option + 1...6 Apply heading style from 1 to 6 of the current note 

Ctrl/Cmd + Period  Begin a bulleted list  

Ctrl/Cmd + / Begin a numbered (sorted) list  

Ctrl/Cmd + Shift + N Clear all the formatting applied to the selected text  

Ctrl/Cmd + L Left-align the selected paragraph 

Ctrl/Cmd + R Right-align the selected paragraph 

Ctrl/Cmd + O Open a OneNote notebook  

Ctrl/Cmd + T Create a new section 

Ctrl/Cmd + N Create a new notebook page 

Ctrl + Shift + G Move keyboard focus to the section list 

Ctrl + G View the list of notebooks 

Ctrl/Cmd + Shift + T Select the page title  

Ctrl/Cmd + P Print the current page 

Page Up Scroll up in the current page 

Page Down Scroll down in the current page 

Tab Increase the indent by one level  

Shift + Tab Decrease the indent by one level  

Ctrl/Cmd + 1 Mark or clear the To Do tag 

Ctrl/Cmd + 2, 3, 4, and 5 Mark or clear the Important, Question, Remember for Later, and Definition tag 

Tab key, after typing a new line of text Create a table 

Tab key Create another column in a table with a single row 

Enter/Return Create another row when at the end cell of a table 

Ctrl/Cmd + Enter/Return Insert a row below the current row in a table 

Alt/Option + Enter/Return Create another paragraph in the same cell in a table 

Shift + Enter/Return  Insert a line break 

Ctrl/Cmd + S  Synchronize the current notebook 

Ctrl/Cmd + Alt/Option + L Lock all password-protected sections 
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Windows Specific Shortcuts 

Home / End  
Move to the beginning or end 
of the line 

Ctrl + Left / Right arrow 
key 

Move one word to the left or 
right 

Backspace / Delete 
Delete one character to the 
left or right 

Ctrl + Backspace / 
Delete  

Delete one word to the left or 
right 

Ctrl + Down / Up key 
Go the next or previous 
paragraph 

Alt + Shift + Right / Left 
arrow key 

Increase or decrease the 
paragraph indent 

Alt + Shift + Up / Down 
key 

Move the selected paragraph 
up or down  

Ctrl + Shift + H Highlight the selected text 

Ctrl + Shift + C / V  
Copy or Paste the formatting 
of the selected text 

Ctrl + Hyphen (-) 
Apply or remove strikethrough 
formatting 

Ctrl + Shift + Equals 
sign (=) 

Apply or remove superscript 
formatting 

Ctrl + Equals sign (=) 
Apply or remove subscript 
formatting 

Alt + Equals sign (=) 

Start a math equation or 
convert the selected text to 
math equation 

Windows logo key + 
Period Insert emoji or symbol 

Alt + Shift + Plus sign 
(+) / Minus sign (-) 

Expand or collapse an outline 
(you can selectively expand or 
collapse the outline at each 
level) 

Ctrl + Alt + Shift + N 
Create a new subpage below 
the current page 

Ctrl + Alt + M  
Move or Copy page to another 
location 

Ctrl + Alt + G 
Move keyboard focus to the 
page list  

Up or Down key / Ctrl + 
Page Up or Down 

After moving keyboard focus 
to the page list, press these 
keys to switch between pages 

Ctrl + Tab Go the next section 

Ctrl + Shift + Tab Go to the previous section 
Alt + Shift + Up / Down 
key 

Move the selected page tab 
up or down 

Ctrl + Home / End  
Scroll to the top or bottom of 
the current page  

Ctrl + Alt + Shift + Plus 
sign (+) / Minus sign (-) Zoom in or out 

Ctrl + Alt + A / S Create or Stop the recording 

Ctrl + Alt + P 
Play the selected audio 
recording 

Alt + Shift + D  Insert the current date 

Alt + Shift + F 
Insert the current date and 
time 

Ctrl + Alt + R  

Create a column to the right 
of the current column in a 
table 

Ctrl + E 
Open a search to search all 
currently opened notebooks 

F9 Synchronize all notebooks 

F6 

Jump between the tab bar, 
navigation pane, and the page 
canvas 

Left or Right arrow keys 

Move between the tabs on a 
ribbon (Home, Insert, Draw, 
and more) 

Spacebar or Enter 

Perform the currently 
selected ribbon command 
(when the selection is over 
Navigation button, press 
Spacebar to enlarge the 
OneNote canvas) 

Alt + Down arrow key Go to the next note container 

Ctrl + Shift + M 
Insert the author name and 
last modified time stamp 

Windows logo key + 
Shift + S 

Copy a screen clipping to the 
clipboard 

 

 

macOS Specific Shortcuts 
Cmd + Left / Right 
arrow key  

Move to the beginning or end of 
the line 

Option + Left / Right 
arrow key 

Move one word to the left or 
right 

Delete / Fn + Delete 
Delete one character to the left 
or right 

Option + Backspace / 
Delete 

Delete one word to the left or 
right 

Option + Down / Up 
key 

Go to the next or previous 
paragraph 

Cmd + ] / [ 
Increase or decrease the 
paragraph indent 

Option + Cmd + Up / 
Down 

Move the selected paragraphs 
up or down 

Ctrl + Cmd + H Highlight the selected text  

Option + Cmd + C / V 
Copy or Paste the formatting of 
the selected text 

Ctrl + Cmd + Hyphen 
(-) 

Apply or remove strikethrough 
formatting 

Option + Shift + Cmd + 
Equals sign (=) 

Apply or remove superscript 
formatting 

Option + Cmd + 
Equals sign (=)  

Apply or remove subscript 
formatting 

Ctrl + Equals sign (=) 

Start a math equation or convert 
the selected text to math 
equation 

Ctrl + Cmd + Spacebar  Insert emoji or symbols 

Ctrl + Shift + Plus sign 
(+) / Minus sign (-) 

Expand or collapse the outline 
(you can selectively expand or 
collapse outline at each level) 

Cmd + N then Option + 
Cmd + ] 

Create a new subpage below the 
current page 

Cmd + Shift + C / M 
Copy or Move page to another 
location 

Ctrl + Cmd + G 
Move keyboard focus to the 
page list 

Up or Down key / Cmd 
+ Page Up or Down 

After moving keyboard focus to 
the page list, press these keys 
to switch between pages 

Cmd + Shift + } Go to the next section 
Cmd + Shift + { Go to the previous section 
Cmd + Option + Up / 
Down key 

Move the selected page tab up 
or down  

Cmd + Up / Down 
Scroll to the top or bottom of the 
current page  

Cmd + Plus sign (+) / 
Minus sign (-) Zoom in or out 
Option + Shift + Cmd + 
R / S Create or Stop the recording 
Option + Shift + Cmd + 
P  

Play the selected audio 
recording 

Cmd + D Insert the current date 
Cmd + Shift + D Insert the current date and time  

Ctrl + Cmd + L / R 

Create a column to the left or 
right of the current column in a 
table 

Cmd + Option + F 
Open a search to search all 
currently opened notebooks 

Shift + Cmd + S Synchronize all notebooks 

F6 

Jump between the tab bar, 
navigation pane, and the page 
canvas (enable F1, F2 as 
standard function keys in 
System Preferences) 

Tab  
Move between the tabs on a 
ribbon 

Spacebar  

Perform the currently selected 
ribbon command (when the 
selection is over Navigation 
button, press Spacebar to 
enlarge the OneNote canvas) 

Press Fn Twice Start dictation 
Ctrl + Option + Cmd + 
L  Use Smart Lookup 
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The Essential List of Microsoft 

Outlook Keyboard Shortcuts 

General Shortcuts 

F1 Help 

F3 Find a contact or other item 

F4 Find or replace 

F7 Spellcheck 

F9 Check for new messages 

F11 Find a contact 

F12 Save As (only in Mail view) 

Delete Delete selected item (message, task, 
or meeting) 

Shift + Ctrl + A Create a new Appointment 

Shift + Ctrl + B Open the Address Book 

Shift + Ctrl + C Create a new Contact 

Shift + Ctrl + E Create a new folder 

Shift + Ctrl + F Open the Advanced Find window 

Shift + Ctrl + H Create a new Office document 

Shift + Ctrl + I Switch to Inbox 

Shift + Ctrl + J Create a new Journal Entry 

Shift + Ctrl + K Create a new Task 

Shift + Ctrl + L Create a new Contact Group 

Shift + Ctrl + M Create a new Message 

Shift + Ctrl + N Create a new Note 

Shift + Ctrl + O Switch to the Outbox 

Shift + Ctrl + P Open the New Search Folder window 

Shift + Ctrl + Q Create a new Meeting Request 

Shift + Ctrl + U Create a new Task Request 

Ctrl + Alt + 2 Switch to Work Week calendar view 

Ctrl + Alt + 3 Switch to Full Week calendar view 

Ctrl + Alt + 4 Switch to Month calendar view 

Message Shortcuts 
Shift + Ctrl + R Reply All 

Ctrl + A Select All 

Ctrl + B Bold 

Ctrl + C Copy selected text 

Ctrl + F Forward message 

Ctrl + H Find and replace text 

Ctrl + K Check names against Address Book 

Ctrl + O Open 

Ctrl + P Print 

Ctrl + Q Mark selected message read 

Ctrl + R Reply 

Ctrl + S Save message as draft 

Ctrl + U Mark selected message unread 

Ctrl + V Paste copied text 

Ctrl + X Cut selected text 

Ctrl + Y Go to folder... 

Ctrl + Z Undo 

Ctrl + Alt + J Mark message as Not Junk 

Ctrl + Alt + M Mark message for download 

Alt + S Send message 

Quick Navigation 
Ctrl + 1 Switch to Mail view 

Ctrl + 2 Switch to Calendar view 

Ctrl + 3 Switch to Contacts view 

Ctrl + 4 Switch to Tasks view 

Ctrl + 5 Switch to Notes 

Ctrl + 6 Switch to Folder List 

Ctrl + 7 Switch to Shortcuts 

Ctrl + Period Switch to next open message 

Ctrl + Comma Switch to previous open message 

Alt + H Go to Home tab 

Alt + Left Go to previous view in main Outlook 
window 

Alt + Right Go to next view in main Outlook window 
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PowerPoint Windows Shortcuts 
 

Creating presentations 

Ctrl + N New presentation 

Ctrl + M New slide 

Ctrl + S Save presentation 

Alt + N, P Insert picture 

Alt + N, S, H Insert shape 

Alt + H, L Slide layout 

Page down Next slide 

Page up Previous slide 

Ctrl + Up Move selected slide up 

Ctrl + Down Move selected slide down 

Ctrl + Shift + Up Move selected slide to the beginning 

Ctrl + Shift + Down Move selected slide to the end 

Alt + H Home tab 

Alt + N Insert tab 

Ctrl + N Add comment 

Ctrl + R Reply to comment 

Ctrl + Q Close PowerPoint 
 

Ribbon 
Alt + F File 

Alt + H Home 

Alt + N Insert 

Alt + G Design 

Alt + K Transitions 

Alt + A Animations 

Alt + S Slide Show 

Alt + R Review 

Alt + W View 

Alt + Y Help 
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Presenting 
F5 Start presentation from beginning 

Shift + F5 Start presentation from current slide 

Alt + F5 Start the presentation in Presenter View 

N Next animation/slide 

P Previous animation/slide 

B Display black slide 

W Display white slide 

S Stop/restart an automatic presentation 

Number, then Enter Go to the slide number specified 

Home To the first slide 

End To the last slide 

T Set timings 

R Record narration and timing 

Alt + P Play/pause media 

Alt + Q Stop media 

Alt + Up Increase volume 

Alt + Down Decrease volume 

Alt + U Mute 

Tab Cycle hotspot 

Shift + F10 Context menu 

Ctrl + T Show taskbar 

Esc End presentation 
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Keyboard Shortcuts for Microsoft Teams
Web Shortcuts Navigation

Ctrl + E Move focus to search box
Ctrl + / Display command list

Ctrl + Shift + G Go to…
Ctrl + Shift + 1 Open Activity tab
Ctrl + Shift + 2 Open Chat tab
Ctrl + Shift + 3 Open Teams tab
Ctrl + Shift + 4 Open Calls tab
Ctrl + Shift + 5 Open Files tab

Left Option + Up Arrow Go to previous list item
Left Option + Down Arrow Go to next list item

Ctrl + Shift + F6 Go to previous section
Ctrl + F6 Go to next section

Ctrl + . (Period) Show keyboard shortcuts
Ctrl + F1 Open Help section

Messaging
Ctrl + N Start new chat

C Move focus to Compose box
Ctrl + Shift + X Expand Compose box
¹Ctrl + Enter Send message

Ctrl + Shift + O Attach file
Shift + Enter Start new line

R Reply to thread

Meetings and Calls
Ctrl + Shift + C Start audio call
Ctrl + Shift + S Accept audio call
Ctrl + Shift + U Start video call
Ctrl + Shift + A Accept video call
Ctrl + Shift + D Decline call
Ctrl + Shift + M Mute/unmute audio
Ctrl + Shift + F Toggle full screen mode

Ctrl + Shift + Space Go to sharing toolbar

²Desktop Shortcuts Navigation
Ctrl + E Move focus to search box
Ctrl + / Display command list

Ctrl + G Go to…
Ctrl + 1 Open Activity tab
Ctrl + 2 Open Chat tab
Ctrl + 3 Open Teams tab
Ctrl + 4 Open Calls tab
Ctrl + 5 Open Files tab

Left Option + Up Arrow Go to previous list item
Left Option + Down Arrow Go to next list item

Ctrl + Shift + Up Arrow Move selected team up
Ctrl + Shift + Down Arrow Move selected team down

Ctrl + Shift + F6 Go to previous section
Ctrl + F6 Go to next section

Ctrl + . (Period) Show keyboard shortcuts
F1 Open Help section

Messaging
Ctrl + N Start new chat

C Move focus to Compose box
Ctrl + Shift + X Expand Compose box
¹Ctrl + Enter Send message

Ctrl + O Attach file
Shift + Enter Start new line

R Reply to thread

Meetings and Calls
Ctrl + Shift + C Start audio call
Ctrl + Shift + S Accept audio call
Ctrl + Shift + U Start video call
Ctrl + Shift + A Accept video call
Ctrl + Shift + D Decline call
Ctrl + Shift + M Mute/unmute audio
Ctrl + Shift + O Toggle video
Ctrl + Shift + F Toggle full screen mode

Ctrl + Shift + Space Go to sharing toolbar
¹The shortcut Enter also works when you haven’t expanded the Compose box. 

²On macOS, replace Ctrl with Cmd and Alt with Option in shortcuts.
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Word Keyboard Shortcuts
 

General 
Ctrl + N Create a new document 

Ctrl + O Open a document 

Ctrl + S Save the document 

Ctrl + P Print the document 

Ctrl + W Close the document 

Ctrl + Z Undo 

Ctrl + Y Redo 

Esc Cancel 
 

Ribbon 
Alt + F Open the File page 

Alt + H Switch to the Home tab 

Alt + N Switch to the Insert tab 

Alt + G Switch to the Design tab 

Alt + P Switch to the Layout tab 

Alt + S Switch to the References tab 

Alt + M Switch to the Mailings tab 

Alt + R Switch to the Review tab 

Alt + W Switch to the View tab 

Alt + Q Search the Ribbon 
 

Navigation 
Ctrl + F Open the Navigation pane to search 

Ctrl + G Open the Go To window to navigate to an element 

Home Move the cursor to the start of the line 

End Move the cursor to the end of the line 

Ctrl + Left arrow Move the cursor left by one word 

Ctrl + Right arrow Move the cursor right by one word 

Ctrl + Up arrow Move the cursor up by one paragraph 

Ctrl + Down arrow Move the cursor down by one paragraph 

Ctrl + Alt + Page up Move the cursor to the top of the screen 

Ctrl + Alt + Page down Move the cursor to the bottom of the screen 

Page up Scroll up a page 

Page down Scroll down a page 

Ctrl + Home Move the cursor to the start of the document 

Ctrl + End Move the cursor to the end of the document 

Shift + F5 Move the cursor to the last change 

Ctrl + Alt + Z Cycle through the last four changes 
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Select Text 
Ctrl + A Select all 

Shift + Arrow keys Select text in the specified direction 

Ctrl + Shift + Left arrow Select the left word 
Ctrl + Shift + Right 
arrow Select the right word 

Shift + Home Select to the start of the line 

Shift + End Select to the end of the line 

Ctrl + Shift + Up arrow Select to the start of the paragraph 
Ctrl + Shift + Down 
arrow Select to the end of the paragraph 

Shift + Page up Select to the top of the screen 

Shift + Page down Select to the bottom of the screen 

Ctrl + Shift + Home Select to the start of the document 

Ctrl + Shift + End Select to the end of the document 

 

Edit Text 
Ctrl + H Open the Replace window to find and replace 

Ctrl + X Cut the selected content 

Ctrl + C Copy the selected content 

Ctrl + V Paste from the clipboard 

Ctrl + Shift + C Copy the selected formatting 

Ctrl + Shift + V Paste the selected formatting 

Alt + Shift + R Copy the header/footer from the previous section 

Ctrl + Backspace Delete the word on the left 

Ctrl + Delete Delete the word on the right 

 

Format Paragraphs 
Ctrl + J Justify paragraph 

Ctrl + E Center paragraph 

Ctrl + L Align paragraph left 

Ctrl + R Align paragraph right 

Ctrl + M Indent paragraph 

Ctrl + Shift + M Remove paragraph indent 

Ctrl + 1 Apply single spacing 

Ctrl + 2 Apply double spacing 

Ctrl + 0 Add or remove a space before the paragraph 

Ctrl + Shift + N Apply the Normal style 

Ctrl + Alt + 1 / 2 / 3 Apply the Heading 1 / 2 / 3 style 

Ctrl + Q Remove paragraph formatting 
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Format Text 
Ctrl + D Open the Font window 

Ctrl + B Apply bold 

Ctrl + I Apply italic 

Ctrl + U Apply underline 

Ctrl + Shift + W Apply underline to words, not spaces 

Ctrl + Shift + D Apply double underline 

Ctrl + Shift + A Format text upper case 

Ctrl + Shift + K Format text small caps 

Ctrl + Shift + > Increase font size 

Ctrl + Shift + < Decrease font size 

 

Tables 
Up arrow Move up a row 

Down arrow Move down a row 

Alt + Home Move to the row's first cell 

Alt + End Move to the row's last cell 

Tab Move to the row's next cell 

Shift + Tab Move to the row's previous cell 

Alt + Page up Move to the column's first cell 

Alt + Page down Move to the column's last cell 
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